Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©June 2009

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
FCC Statement

(Federal Communications Commission)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC Output of 19V, 1.58A or 19V, 1.57A (30 Watts) minimum AC/DC Adapter.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD
Instructions for Care and Operation

The computer is rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
   - Do not expose it to excessive heat.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t store the computer in a humid environment.

3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted
   - Do not turn off the power until you properly shut down all programs.
   - Do not turn off any peripheral devices when the computer is on.
   - Do not disassemble the computer by yourself.
   - Perform routine maintenance on your computer.

5. **Take care when using peripheral devices.**
   - Use only approved brands of peripherals.
   - Unplug the power cord before attaching peripheral devices.
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

![Power Safety Warning]

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Pay careful attention to the instructions on swapping the battery.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the computer’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
4. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
5. Put the computer in its carrying bag and secure it with the bag’s straps.
6. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
7. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your computer is completely powered off before putting it into a travel bag (or any such container).
Preface

On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

Hand-carry the computer - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

• Set the Windows Power Schemes to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
Preface

Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.
Preface

Upgrading the Memory and HDD/SSD
If you want to upgrade your computer by upgrading the system memory or the hard disk drive/solid state drive you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the mainboard.

---

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
# Preface

## Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice</td>
<td>I</td>
</tr>
<tr>
<td>FCC Statement</td>
<td>II</td>
</tr>
<tr>
<td>Instructions for Care and Operation</td>
<td>IV</td>
</tr>
<tr>
<td>Power Safety</td>
<td>V</td>
</tr>
<tr>
<td>Battery Precautions</td>
<td>VI</td>
</tr>
<tr>
<td>Travel Considerations</td>
<td>VII</td>
</tr>
<tr>
<td>Cleaning</td>
<td>XI</td>
</tr>
<tr>
<td>Servicing</td>
<td>XI</td>
</tr>
<tr>
<td><strong>Quick Start Guide</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Introduction</td>
<td>1-2</td>
</tr>
<tr>
<td>LED Backlight LCD</td>
<td>1-2</td>
</tr>
<tr>
<td>Advanced Users</td>
<td>1-5</td>
</tr>
<tr>
<td>Beginners and Not-So-Advanced Users</td>
<td>1-5</td>
</tr>
<tr>
<td>Warning Boxes</td>
<td>1-5</td>
</tr>
<tr>
<td>Not Included</td>
<td>1-6</td>
</tr>
<tr>
<td>System Software</td>
<td>1-7</td>
</tr>
<tr>
<td>System Startup</td>
<td>1-8</td>
</tr>
<tr>
<td>Operating System Setup</td>
<td>1-9</td>
</tr>
<tr>
<td>System Software Installation</td>
<td>1-10</td>
</tr>
<tr>
<td>Operating System Installation</td>
<td>1-10</td>
</tr>
<tr>
<td>Tablet Notebook Input</td>
<td>1-11</td>
</tr>
<tr>
<td>Calibrating the Touch Panel</td>
<td>1-11</td>
</tr>
<tr>
<td>Pen Options &amp; Tablet Settings</td>
<td>1-13</td>
</tr>
<tr>
<td>On-Screen Keyboard</td>
<td>1-14</td>
</tr>
<tr>
<td>System Map: LCD Panel View - Front</td>
<td>1-15</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>1-16</td>
</tr>
<tr>
<td>Function Buttons</td>
<td>1-17</td>
</tr>
<tr>
<td>On-Screen Menu</td>
<td>1-18</td>
</tr>
<tr>
<td>G-Sensor - Hard Disk Drive Protection</td>
<td>1-20</td>
</tr>
<tr>
<td>System Map: Rear View</td>
<td>1-21</td>
</tr>
<tr>
<td>System Map: Left View</td>
<td>1-22</td>
</tr>
<tr>
<td>System Map: Right View</td>
<td>1-23</td>
</tr>
<tr>
<td>System Map: Top &amp; Bottom Views</td>
<td>1-24</td>
</tr>
<tr>
<td>Windows Vista Start Menu &amp; Control Panel</td>
<td>1-25</td>
</tr>
<tr>
<td>Video Features</td>
<td>1-26</td>
</tr>
<tr>
<td>Display Devices &amp; Options</td>
<td>1-26</td>
</tr>
<tr>
<td>Power Options</td>
<td>1-28</td>
</tr>
<tr>
<td>Optimizing Battery Life</td>
<td>1-29</td>
</tr>
<tr>
<td>Removing the Battery</td>
<td>1-30</td>
</tr>
<tr>
<td>Hot-Swapping the Battery</td>
<td>1-31</td>
</tr>
<tr>
<td><strong>Features &amp; Components</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>Hard Disk Drive/Solid State Drive</td>
<td>2-2</td>
</tr>
</tbody>
</table>
**Preface**

5-in-1 Card Reader .......................................................... 2-3
ExpressCard Slot .............................................................. 2-4
    Inserting and Removing ExpressCards .......................... 2-4
Audio Features ................................................................. 2-5
Tablet PC Options ............................................................. 2-6
    Screen Orientation .................................................... 2-7
Adding a Printer ............................................................... 2-12
    USB Printer ............................................................. 2-12
    Parallel Printer ......................................................... 2-12

**Power Management**

Overview ........................................................................... 3-1
The Power Sources ........................................................... 3-2
    AC/DC Adapter ........................................................ 3-2
    Battery ..................................................................... 3-2
Turning on the Computer .................................................. 3-3
Power Plans ...................................................................... 3-4
Power-Saving States .......................................................... 3-6
    Sleep ........................................................................ 3-6
    Hibernate ................................................................. 3-7
    Shut Down .................................................................. 3-7
Configuring the Power Buttons .......................................... 3-8
    Resuming Operation .................................................. 3-9
    Battery Information ................................................... 3-10
    Battery Power .......................................................... 3-10
Conserving Battery Power ................................................. 3-11
Battery Life ...................................................................... 3-12
New Battery ..................................................................... 3-12
Recharging the Battery with the AC/DC Adapter ................. 3-12
Proper handling of the Battery Pack ................................. 3-13
Battery FAQ ..................................................................... 3-14
Battery Gauge .................................................................. 3-16
Battery Indicators ............................................................ 3-17

**Drivers & Utilities**

What to Install .................................................................. 4-1
Module Driver Installation ............................................... 4-1
Driver Installation ............................................................ 4-2
    Updated/Reinstalling Individual Drivers ...................... 4-4
    User Account Control (Win Vista) ............................... 4-4
    Windows Security Message ....................................... 4-4
    New Hardware Found ................................................ 4-4
    Driver Installation Procedure ..................................... 4-5
    Chipset ..................................................................... 4-5
    Video ........................................................................ 4-5
    LAN ......................................................................... 4-5
    Touch Panel Application .......................................... 4-6
    Pop Menu Utility ....................................................... 4-6
    Audio ....................................................................... 4-6
    Optional Drivers ....................................................... 4-7
# Preface

- Configuring the COM Port for the GPS Module ..... 6-23
- RFID Reader Module ........................................... 6-24
- Configuring the COM Port for the RFID Reader ..... 6-25

# Troubleshooting

- Overview .......................................................... 7-1
- Basic Hints and Tips ............................................. 7-2
- Backup and General Maintenance ......................... 7-3
- Viruses ............................................................... 7-4
- Adding New Hardware/Software ......................... 7-5
- Problems and Possible Solutions ............................ 7-7

# Interface (Ports & Jacks)

- Ports and Jacks ................................................... A-1

# Intel Video Driver Controls

- Video Driver ...................................................... B-1

# Specifications

- Processor Options ............................................. C-2
- Core Logic ....................................................... C-2
- LCD Options ..................................................... C-2
- Memory ............................................................. C-2
- Video Adapter ..................................................... C-2
- Video Camera ..................................................... C-2
- BIOS ................................................................ C-2
- Drop Protection .................................................. C-2
- Storage ............................................................. C-2
- Audio ............................................................... C-2
- Button Keys ....................................................... C-2
- Interface ........................................................... C-2
- Card Reader/ExpressCard .................................... C-3
- Communication .................................................. C-3
- Security ............................................................ C-3
- Power Management ............................................ C-3
- Power ............................................................... C-3
- Operating System .............................................. C-3
- Environmental Spec .......................................... C-3
- Dimensions & Weight ......................................... C-3
- Indicators .......................................................... C-3
- Optional ............................................................ C-3
- Factory Options .................................................. C-3

# Windows XP Information

- Tablet Notebook Input .......................................... D-2
- Calibrating the Touch Panel .................................. D-2
- On-Screen Menu .................................................. D-4
- G-Sensor - Hard Disk Drive Protection .................. D-6
- Windows XP Start Menu & Control Panel ............. D-7
- Audio Features .................................................. D-8
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk/Solid State Drive, 5-in-1 card reader, ExpressCard), Audio, Tablet PC Options & Printer.
- **Chapter 3** The computer’s power saving options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- **Chapter 6** A quick guide to the computer’s Bluetooth, Wireless LAN, PC Camera, GPS, RFID Reader modules (some of which are optional).
- **Chapter 7** A troubleshooting guide.
- **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- **Appendix B** Information on the Intel Video driver controls.
- **Appendix C** The computer’s specification.
Introduction

This semi-ruggedized tablet computer provides an ideal platform for outdoor computer use with an IP54 (Ingress Protection) rating against dust and spray and features an optional sunlight readable LCD touch panel; all touch panels support both finger and stylus pen input. Hard disk drive protection is provided by G-Sensor software that protects the hard disk drive from a drop of up to 40CM when the system is powered on, and the hard disk drive is shock mounted offering protection from a drop of 120CM when the system is powered off.

Figure 1 - 1 - Spray Resistant Computer

LED Backlight LCD

The LED Backlight LCDs on this computer model allow for greater color quality and consume less power than conventional fluorescent LCDs, and therefore can save significant battery life. In addition the LED backlit LCD allows for clearer reading in sunlit conditions.
Optional Accessories
This computer features a range of options including a GPS module (including an optional active aerial), HF RFID reader, as well as a range of optional accessories including car adapter, charger box, USB to RS 232 cable, hand holder, shoulder strap and carrying handle.

Figure 1 - 2 - Optional Accessories
Quick Start Guide

Attaching the Optional Hand Holder.
The hand holder offers ease of use when using the computer on the move outdoors. Attach the hand holder as follows:

1. Place the hand holder at the rear of the computer with the screws facing inwards towards the computer.
2. Align the screws on the hand holder with the screw holes 1 - 4 in the rear of the case (you may need to adjust the straps to do this).
3. Fully tighten the screws 5 - 8 using a flathead screwdriver.
4. Put your hand through the hand holder and secure it with the velcro straps 9 & 10.

Figure 1 - 3 - Attaching the Optional Hand Holder
Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1 and “BIOS Utilities” on page 5 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a 🖋 of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in the Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a 🖋 as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the 🕵️️ symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included

Operating Systems (e.g. *Windows Vista* or *XP*) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1 (you will need an external USB optical device drive). Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 1 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported.

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP - SP3 (32-bit) Home or Professional</td>
<td>In order to run Windows XP without limitations or decreased performance, your computer requires a minimum 512MB of system memory (RAM)</td>
</tr>
<tr>
<td>Windows Vista - SP1 (32-bit) Home Basic Edition</td>
<td>In order to run Windows Vista without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).</td>
</tr>
</tbody>
</table>

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.
Quick Start Guide

System Startup

1. Remove all packing materials.
2. Place the computer flat on a stable surface with LCD panel facing upwards.

3. Securely attach any peripherals you want to use with the computer (e.g. keyboard or mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Press the power button to turn the computer “on”.
6. Remove the Stylus pen to use as your input device.
7. The LED indicators show the power and battery status of the computer.

Figure 1 - 4 - Computer with AC/DC Adapter Plugged-In / Computer with Stylus Pen

Shutdown

Please note that you should always shut your computer down by choosing the Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.

External Optical (CD/DVD) Device Drives

To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.

Touch Panel Input Device

Do not use any sharp or point-ed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device. Be very careful not to press too hard with the stylus pen when using it as the input device.
Operating System Setup

If you are installing new system software, or are re-configuring your computer for a different system, make sure you configure the appropriate OS setting in the BIOS before installing a new operating system.

1. Start-up the computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select “Installed O/S” and make sure the appropriate operating system is selected.
3. Go to the Exit menu and select “Exit Saving Changes” (or press F10 and select “Yes” then press Enter) and press Enter to exit the BIOS and reboot the computer.

Figure 1 - 5 - Advanced BIOS Menu
System Software Installation
Your computer may come with an operating system software and all necessary drivers pre-installed. If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers after installing the operating system.

Operating System Installation
Prepare the following before installing the Microsoft Windows Vista Home Basic Edition - 32-bit (with Service Pack 1) or Microsoft Windows XP - 32-bit (with Service pack 3) operating system software:

- An external USB CD/DVD device drive (the Microsoft Windows OS CD should be inserted into this drive).
- A USB keyboard connected to one of the USB ports.

4. Attach the external USB CD/DVD device drive (containing the Microsoft Windows OS CD) to the computer.
5. Start-up your computer and press <F2> to enter the BIOS.
6. Go to the Boot menu (see “Boot Menu” on page 5 - 13).
7. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the boot order from the Boot priority order menu (use the “+” and “-” keys to move the device up and down the priority order.
8. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
9. As the computer starts up, press a key when you see the message "Press any key to boot from CD".
10. The system software will prompt you through the installation procedure (see the Microsoft Windows OS documentation for more details).
11. Install the drivers as per the instructions in Chapter 4 (in the order indicated in Table 4 - 1, on page 4 - 3).
Tablet Notebook Input

Use the stylus pen provided to interact with the computer in the same way you would use the mouse (tap twice to double-click and keep the pen in contact with the screen to right-click). Before using the stylus pen you should calibrate the touch screen.

Calibrating the Touch Panel
1. Double-click the **Touch tool** utility icon on the desktop OR from the **Touch Package** folder in the **Programs/All Programs** group (the driver must be installed).
2. Click **General**.
3. Click **9 pts Linearity** (if you would prefer to calibrate more accurately, or are having distortion/tracking problems, then click **Advance** and choose either **25 pts Linearity**).

![Figure 1 - 6 - Touch Package (General & Advance)](image-url)
Quick Start Guide

4. Use the stylus pen to touch the blinking symbol until symbol changes color (maintain contact until the symbol stops blinking) and you will be prompted to lift up the pen.

5. Repeat the process for all the remaining screen points.

6. Click **Free Draw** (button) to test the calibration.

7. Use the **Mouse Emulation** and **Sound** control panels to further adjust the settings to your preference.

---

**Touch Panel Input Device**

Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device. Be very careful not to press too hard with the stylus pen when using it as the input device.

**Screen Distortion**

If you experience any line distortion, or tracking inaccuracy, recalibrate the touch screen using 25pts of calibration (click the **Advance** item in the **Touch package** and click **25pts Linearity**).

---

*Figure 1 - 7 - Screen Calibration*
Pen Options & Tablet Settings
Configure the stylus pen input settings, from the Pen and Input Devices control pane in Windows Vista; the Tablet PC Settings control panel allows you to configure the tablet screen appearance. Access the control panels as follows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mobile PC and click Pen and Input Devices (or just double-click Pen and Input Devices).
3. Click Mobile PC and click Tablet PC Settings (or just double-click Tablet PC Settings).

![Figure 1 - 8 - Pen and Input Devices & Tablet PC Settings Control Panel](image)

Tablet PC Options
See “Tablet PC Options” on page 2 - 10 for further information on Tablet PC settings etc.
Quick Start Guide

On-Screen Keyboard
The On-Screen Keyboard allows you to input text without the use of a keyboard. Move the pen over any character and then tap it to activate it.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Ease of Access** and click **Start On-Screen Keyboard**.
3. Use the stylus pen to tap the appropriate keys to input.
4. Click the **Help** menu to get more information.

![On-Screen Keyboard](image)

*Figure 1 - 9 - On-Screen Keyboard*

**Note:** You can use the **Ease of Access** icon at system startup (at the point of system password entry) to bring up the On-Screen Keyboard and input the system password.
System Map: LCD Panel View - Front

Figure 1 - 10
LCD Panel View - Front

1. Built-In Microphone
2. LED Indicators
3. LCD Touch Panel Screen
4. Speakers
5. Fingerprint Reader
6. 5 Function Buttons
7. Protective Surround
Quick Start Guide

LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>Blinking</td>
<td>Green</td>
<td>The Computer is in Sleep Mode</td>
</tr>
<tr>
<td>Battery</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>Blinking</td>
<td>Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>Green</td>
<td>Hard Disk / System Activity</td>
</tr>
</tbody>
</table>

*Table 1 - 2 - LED Indicators*
Function Buttons
The function buttons provide easier access to functions on the computer.

<table>
<thead>
<tr>
<th>Key Buttons</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Mode / Zoom Mode</td>
<td>Toggle</td>
<td></td>
</tr>
<tr>
<td>Access / Hide the On-Screen Menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Mode = Page Up / Page Down</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Mode (for Picture files - Does NOT Zoom the Camera) = Zoom In / Zoom Out</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run the BisonCap Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If the BisonCap Application is Running = Take Still Picture</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table 1 - 3 - Function Buttons*

Press the **Camera Button** to run the **BisonCap** application program (for PC Camera). When the **BisonCap** application program is running, press the **Camera Button** to take a still picture.

Use the **Zoom Mode** (press the Mode Toggle **Button to toggle Zoom and Page Modes**) to zoom in and out of open picture files (e.g. bitmap, jpeg files etc.).

Use the **Page Mode** to **Page Up** and **Page Down** text files etc.
On-Screen Menu

Pressing the Menu button (or double-click the Pop Menu icon in the taskbar) on the computer will bring up the on-screen menu (make sure you install the pop menu driver - see “Pop Menu Utility” on page 4 - 6). Use the stylus pen to touch any of the buttons to activate the control. Press the Menu button (or double-click the Pop Menu icon in the taskbar) to quit the menu. Use the stylus pen to tap the appropriate on-screen button to adjust the setting and the button will display the current status.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the On-Screen Menu button to toggle power to any Wireless/Bluetooth/GPS module, and check the menu icon to see if the module is powered on or not.

Figure 1 - 11 - On-Screen Menu
### Table 1 - 4 - On-Screen Menu Buttons

<table>
<thead>
<tr>
<th>Function</th>
<th>On-Screen Button</th>
<th>Function</th>
<th>On-Screen Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness Decrease/Increase</td>
<td>![Icon]</td>
<td>Bluetooth Module Power Toggle</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Volume Decrease/Increase</td>
<td>![Icon]</td>
<td>PC Camera Module Power Toggle</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Mute Toggle</td>
<td>![Icon]</td>
<td>G-Sensor Protection Mode Toggle</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Display Toggle</td>
<td>![Icon]</td>
<td>GPS Module Power Toggle</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Display Battery Level</td>
<td>![Icon]</td>
<td>RFID Module Power Toggle</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

**Note:** Any modules not included in your purchase configuration will appear grayed out when the key combination is pressed.

**Note:** Use the stylus pen to tap the appropriate on-screen button to adjust the setting.

**Note:** The default setting for the Wireless LAN and PC Camera modules is OFF.
Quick Start Guide

G-Sensor - Hard Disk Drive Protection

The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor does not function with Solid State Drives) in the event that the computer is accidentally dropped when the system is powered on (40cm drop approved when the system is powered on and 120cm drop approved when the system is powered off). Press the Menu button (or double-click the Pop Menu icon in the taskbar) to bring up the on-screen menu and use the stylus pen to toggle the G-Sensor mode ON or Off.

If the system is dropped, and the G-Sensor is on, the system will briefly pause (for about 3 seconds) to protect the hard disk and will display an on-screen message and an audible warning) to inform that the hard disk is protected. Allow the system about 3 seconds to recover before using it again.

![G-Sensor - HDD Protected Message](image)

Set the G-Sensor On or Off in accordance with the manner the computer is being used. If the computer is sitting on the desktop (or if you find the G-Sensor is too sensitive), then the G-Sensor can be turned Off. The G-Sensor will be automatically activated to offer protection when the computer enters Sleep or Hibernate modes (even if turned off).
System Map: Rear View

1. Built-In PC Camera
2. GPS Active Aerial Socket (for optional Active Aerial)
3. Protective Surround
4. Stylus Pen & Holder
5. Battery Gauge
6. Battery

Battery Information
See “Battery Information” on page 3-9 for full instructions.
Quick Start Guide

System Map: Left View

1. Security Lock Slot
2. Stylus Pen & Holder
3. DC-In Jack
4. 1 * USB 2.0 Port

Mouse & Keyboard
You can use any external mouse and keyboard attached to any of the USB ports.

Touch Panel Input Device
Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device. Be very careful not to press too hard with the stylus pen when using it as the input device.

External Optical (CD/DVD) Device Drives
To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.
System Map: Right View

Figure 1 - 15
Right View

1. Headphone-Out Jack
2. External Monitor Port
3. Card Reader Cover
4. ExpressCard 34 Slot (see below)
5. 5-in-1 Card Reader

ExpressCard Support
There is a list of approved ExpressCard modules listed on Table E - 1, on page E - 1. Please make sure any ExpressCards modules you use with this computer are included in the list. Contact your service center for further information.

5-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

- SD (Secure Digital)
- Mini SD (requires PC adapter)
- SDIO (requires PC adapter)
- MMC (MultiMedia Card)
- RS MMC (requires PC adapter)
System Map: Top & Bottom Views

1. Strap Holders (for Carrying Strap)
2. Power Button
3. RFID (Radio Frequency Identification) Reader (Factory Option)
4. RJ-45 LAN Jack
5. 1 * USB 2.0 Ports

External Optical (CD/DVD) Device Drives
To install applications and drivers etc. you will need to attach an external optical CD/DVD device to the USB ports.
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers provided. To see all controls it may be necessary to toggle to Classic View on.
Quick Start Guide

Video Features

You can switch display devices, and configure display options, from the Display Settings control panel (in Personalization) in Windows Vista as long as the appropriate Intel video driver is installed.

To access Display Settings in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: (Figure 1 - 18 on page 1 - 27).
4. Click the arrow, and scroll to the preferred setting in Colors: (Figure 1 - 18 on page 1 - 27).
5. Click Advanced Settings (button) (Figure 1 - 18 on page 1 - 27) and click Intel(R) GMA Driver for ultra mobile (tab).
6. Click Graphics Properties (button) (Figure 1 - 18 on page 1 - 27) to access the Intel GMA Driver for ultra mobile control panel (this control panel can also be accessed by double-clicking Intel(R) GMA Driver for ultra mobile control panel in Windows Classic View).
7. The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display connected to the external monitor port as your display device. Note: MID (Mobile Internet Device) is the computer’s LCD display.
Quick Start Guide

Figure 1 - 18 - Display Properties Desktop

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Mode</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Intel(R) Dual Display Clone Mode</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended Desktop Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

Table 1 - 5 - Display Options
Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 25) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration options.

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 19 - Power Options
Optimizing Battery Life
To optimize your battery life, follow the instructions below and also see “Conserving Battery Power” on page 3-10. You can check the battery’s current capacity from the gauge at the rear of the computer (see “Battery Gauge” on page 3-16).

Set the Power Plan to Power saver:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Power Options (icon); Power Options (icon) is in the System and Maintenance category.
3. Click Power saver (button) in select Select a power plan.
4. Close the control panel.

Power Off any modules not in use:
1. Press the Menu button (or double-click the Pop Menu icon in the taskbar).
2. Use the stylus pen to touch any of the buttons to turn off any module not in current use (e.g. camera, Bluetooth, WLAN etc.).

Figure 1 - 20 - Power Saver Power Plan
Quick Start Guide

Removing the Battery

If you need to remove the battery follow the procedure below.
1. Turn the computer off (unless you are hot swapping the battery), and turn it over.
2. Remove screws at points 1 and 4.
3. Remove the battery cover 5.
4. Grip the tab 6 and lift the battery out in the direction of the arrow 7.

Figure 1 - 21 - Battery Removal
Hot-Swapping the Battery

If you have more than one battery included in your purchase option you can swap the battery while the system is running.

1. Check the level of the backup battery from the on-screen menu.
2. Press the battery level button to display the indicator:

```
Figure 1 - 22 - Battery Level Indicator
```

3. The lower indicator will display the bridge battery level and the upper indicator displays the main battery level.
4. If the bridge battery level indicated "Ready" you can swap batteries.
5. Remove the AC/DC adapter cable from the DC-In jack (if applicable) and an on-screen icon will indicate the main battery status if less than a 3% charge remains.

```
Figure 1 - 23 - Bridge Battery Ready Indicators
```

6. You can then remove the battery as per the instructions in “Removing the Battery” on page 1 - 30.
7. When the battery is removed a beep will indicate that the system is running on bridge battery power (you have up to 3 minutes maximum to swap the battery depending upon applications being used).
8. When a new sufficiently charged battery is inserted the beep will stop.
Quick Start Guide
Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components of the computer.

• Hard Disk Drive/Solid State Drive
• 5-in-1 Card Reader
• ExpressCard Slot
• Audio Features
• Tablet PC Options
• Adding a Printer
2 - 2 Hard Disk Drive/Solid State Drive

Upgrading the HDD/SSD

If you want to upgrade your computer by upgrading the hard disk drive/solid state drive you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the computer.

Hard Disk Drive/Solid State Drive

The hard disk drive or solid state drive (factory options) is used to store your data in the computer. The HDD/SSD can be taken out (please check with your service representative before undertaking any upgrade or replacement procedures to find out if this will VOID your warranty) to accommodate other 2.5" serial (SATA) HDDs/SSDs (SLC) with a height of 9.5 mm.

The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor does not function with Solid State Drives) in the event that the computer is accidentally dropped when the system is powered on (40cm drop approved when the system is powered on and 120cm drop approved when the system is powered off). Press the Menu button (or double-click the Pop Menu icon in the taskbar) to bring up the on-screen menu and use the stylus pen to toggle the G-Sensor mode ON or Off. See “G-Sensor - Hard Disk Drive Protection” on page 1 - 20 for more details.
5-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- Mini SD (requires PC adapter*)
- SDIO (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep card reader cover closed when not in use. This will help prevent foreign objects and/or dust getting into the card reader.

Figure 2 - 1
Right View

1. Card Reader Cover
2. Card Reader
ExpressCard Slot

The computer is equipped with an **ExpressCard 34** slot. ExpressCards are the successors to PCMCIA (PC Cards). Make sure you install the Card Reader driver.

**ExpressCard Slot Cover**

Make sure you keep card reader cover closed when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

**Figure 2 - 2**

*Right View*

1. Card Reader Cover
2. ExpressCard Slot

**Inserting and Removing ExpressCards**

- Align the ExpressCard with the slot and push it in until it locks into place.
- To remove an ExpressCard, simply press the card to eject it.

**ExpressCard Support**

There is a list of approved ExpressCard modules listed on **Table E - 1, on page E - 1**. Please make sure any ExpressCards modules you use with this computer are included in the list. Contact your service center for further information.
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may be adjusted by means of the On-Screen Menu buttons or the volume icon in the taskbar (see sidebar).

Sound Volume Adjustment

The sound volume level is set using the volume control within Windows (and the volume function keys on the computer). Click the volume icon in the taskbar to check the setting.

Right-click the icon to access the menu above.
Tablet PC Options

Chapter 1 contains basic information on calibration (see “Calibrating the Touch Panel” on page 1 - 11), pen options and tablet settings (see “Pen Options & Tablet Settings” on page 1 - 13) and the On-Screen keyboard (see “On-Screen Keyboard” on page 1 - 14). The following pages will add some more detailed information on Tablet PC input and settings.
Screen Orientation
If you prefer to orientate the screen differently follow these steps.

Screen Orientation - Windows Control Panel
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mobile PC (or just double-click Tablet PC Settings) and then click Tablet PC Settings.
3. Click Display (tab) and select the orientation required.
4. Click Apply.
5. It is advisable to calibrate the touch panel after rotating the screen (see page 1 - 11).
Screen Orientation - Intel GMA Control Panel

1. Open the Display Settings control panel (see “Video Features” on page 1 - 26) and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Go to the Intel GMA control panel (see “Video Features” on page 1 - 26) and click Display Settings.
4. Make sure Enable Rotation is ticked and choose the degree of rotation.
5. Click Apply and OK to confirm the setting change.
6. It is advisable to calibrate the touch panel after rotating the screen (see page 1 - 11).
Touch Package Settings
You can also configure the pen options from the Touch Package control panel.

1. Double-click the Touch tool utility icon on the desktop OR from the Touch Package folder in the Programs/All Programs group (the driver must be installed).
2. Click Mouse Emulation.
3. Double-click either Drawing Mode or Button Mode to configure the Right-Click or Double-Click settings (you can also disable touch altogether if you prefer).

Other Tools
The Touch Package Touch Tool utility also allows you to configure Sound options (for when you touch and lift up the stylus pen) and gives you quick access to system information (Advance > System Information Tool).

Figure 2-6
Touch Package Mouse Emulation
Pen and Input Devices
You can configure the pen options from the Pen and Input Devices control panel.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mobile PC (or just double-click Pen and Input Devices) and then click Pen and Input Devices.
3. Select the Pen action from the left menu and click Settings to configure the setting.
4. You can select the sensitivity of the double-tap speed and distance, the sensitivity and duration of press and hold (for right-clicking), and you can test the settings from this menu.

Figure 2 - 7
Double Tap & Press and Hold Settings
Other Useful Windows Vista Features for Tablet PC Users

Multi-Select Files in Windows Explorer
The option to multi-select files in Windows Explorer in Windows Vista is very useful when using a pen as your input device.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Appearance and Personalization and click Folder Options (or just double-click Folder Options).
3. Click View (tab), and make sure Use check boxes to select items is ticked.
4. Click OK to save the setting.
5. Check boxes will appear in open folders to allow you to easily multi-select files with a pen.

Figure 2 - 8
Folder Options & Multi-Select Files
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. **Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar, however you will need to purchase a parallel to USB converter.

**Parallel Printer**

After setting up the printer attach the parallel cable to the printer.

Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

**Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

Hibernate Mode In Windows Vista SP1

If you are using Windows Vista SP1 with 4GB RAM installed, see page 7 - 10 for information on Hibernate.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Press the power button and then release it to turn the computer “on”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).
Turning on the Computer

Now you are ready to begin using your computer. To turn it on press the power button and release it.

When the computer is on, you can use the power button as a Sleep/Hibernate hotkey button when you press and release it in less than 4 seconds (pressing the power button without releasing it for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

---

**Forced Off**

If the system “hangs”, and the Ctrl + Alt + Del key combination on an attached keyboard doesn’t work, press and hold the power button for 4 seconds, or longer, to force the system to turn itself off.

**Power Button Sleep**

Sleep is the default power mode when the power button is pressed and released in less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 8 for details).

---

**Shut Down**

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.
Power Plans

The computer can be configured to conserve power by means of **power plans**. You can use (or modify) an existing **power plan**, or create a new one.

The settings may be adjusted to set the **display** to turn off after a specified time, and to send the computer into **sleep** after a period of inactivity.

Click **Change plan settings** and then click **Change advanced power settings** to access further configuration options in **Advanced Settings**.

---

**Figure 3 - 1**

**Power Plan - Advanced Settings**

---

**Resuming Operation**

See **Table 3 - 1, on page 3 - 9** for information on how to resume from a power-saving state.

**Password**

It is recommended that you enable a password on system resume in order to protect your data.
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.

If you are playing video files (e.g. mpeg files) on the computer, it is recommended that you choose the **High Performance** power plan.

Use the **Power Settings** control to allow the Intel(R) GMA Driver for ultra mobile control panel to adjust the power options when the computer is running on battery power (see “Power Settings” on page B - 5).
Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows Vista combines the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

Power Button

The Power Button in the Start Menu (in Classic View use the Shut Down button) can be used to send the computer into a power-saving state.

Sleep Mode & Mobile PC Battery

A mobile PC in Sleep uses very little battery power.

After an extended period of time the computer will save any open documents and applications to hard disk.
Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from shut down takes longer than from Sleep or Hibernate.
Configuring the Power Buttons

The power button, sleep button (on any attached keyboard) or Sleep command from the Lock Button Menu in *Windows Vista* may be set to send the computer in to a power-saving state.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the **Power Options** menu by clicking **Require a password on wakeup** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

![Figure 3 - 4](image)

**Power Options**

**Define Power Buttons**
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button on an attached keyboard.

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon/Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press the Sleep Button on any attached keyboard</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery) Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td>Move any attached Mouse/Touch the Screen</td>
</tr>
</tbody>
</table>

Table 3 - 1
Resuming Operation

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed and released in less than **4 seconds** (pressing the power button for longer than this will force the computer to shut down).
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a **power plan** that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

---

**Figure 3 - 6**

Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used etc.
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 1 - 30.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 16 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

**Caution**

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer's instructions.

**Damaged Battery Warning**

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. **Create a power plan** for discharging the battery and set all the options to **Never**.
3. Click **Change plan settings** (after saving it) and click **Change advanced power settings**.

![Figure 3 - 7
Power Plan - Create](image-url)
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears).

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

---

**Figure 3 - 8**

Power Options
Advanced Settings - Battery
Power Management

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Battery Gauge
The battery gauge at the rear of the computer provides a clear indication of remaining battery life. Firmly press the PUSH CHECK button and the Led will show the current battery level.

Figure 3 - 9
Battery Capacity Gauge
Battery Indicators

On-screen indicators will display the battery status if the battery level button is pressed or the AC/DC adapter is not connected.

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The on-screen battery level button is pressed.</td>
<td><img src="image" alt="Battery Level 100%" /></td>
<td>Main Battery Level Indicator</td>
</tr>
<tr>
<td>AC/DC Adapter Connection Removed</td>
<td><img src="image" alt="Battery Level Ready" /></td>
<td>Bridge Battery Level Indicator</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Battery Level Alert" /></td>
<td>Main Battery Level is Under 3% Plug-in the AC/DC Adapter</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Battery Level Change" /></td>
<td>Main Battery Level is Under 3% Change Battery</td>
</tr>
</tbody>
</table>

Table 3-1
On-Screen Battery Indicators
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

Note: For Windows XP driver installation information see “Driver Installation” on page D - 32.

What to Install

You will need to attach a CD/DVD drive to the computer in order to access the drivers on the Device Drivers & Utilities + User’s Manual disc. This contains the drivers and utilities necessary for the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, PC Camera and Fingerprint modules are provided in “Modules” on page 6 - 1.

Note: The operating system is the default setting for Bluetooth control in Windows Vista, and does not require a driver. See “Bluetooth Module” on page 6 - 2 for configuration instructions.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the optional driver menu.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.

2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
Drivers & Utilities

Manual Driver Installation

Click *Browse CD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “*Windows Update*” on page 4 - 6 for instructions.

## Table 4 - 1 - Driver Installation

<table>
<thead>
<tr>
<th>Vista (SP1) Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Touch Panel Application</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Pop Menu Utility</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page 6 - 6</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 6 - 11</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page 6 - 17</td>
</tr>
</tbody>
</table>

*Windows Vista Service Pack 1*

Make sure you install **Windows Vista Service Pack 1** (or a Windows Vista version which includes Service Pack 1) **before installing any drivers**. Go to the Microsoft website for download details, or contact your service center.
Drivers & Utilities

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of the driver installation procedure, click Continue/Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Driver Installation Procedure

Insert the *Device Drivers & Utilities + User’s Manual* disc into your attached CD/DVD drive and click **Install Drivers** (button), or **Option Drivers** (button) to access the optional driver menu.

**Chipset**
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

**Video**
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

**LAN**
1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

---

**Driver Installation General Guidelines**

The driver installation procedure outlined in this Chapter (and in *Chapter 7 Options & Modules*), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.
Drivers & Utilities

Touch Panel Application
1. Click 4.Install Touch Panel Driver > Yes.
2. Click Next > Next > Install.
3. Click Finish.
4. Click OK to restart the computer.
5. You will then need to calibrate the touch panel (see “Calibrating the Touch Panel” on page 1 - II).

Pop Menu Utility
1. Click 5.Install POP Menu Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “On-Screen Menu” on page 1 - 18 for details.

Audio
1. Click 6.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Check for updates (Security), or double-click Security Center and click Windows Update.
3. Double-click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to install the updates.
Optional Drivers
See the pages indicated overleaf for the driver installation procedures for any modules included in your purchase option.

BlueTooth Module
Note: The operating system is the default setting for Bluetooth control in Windows Vista, and does not require a driver. See “BlueTooth Module” on page 6 - 2 for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on page 6 - 6, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on page 6 - 11, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module” on page 6 - 17, and check the installation procedure.
Drivers & Utilities
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The Setup utility

Note that you will need to attach a USB keyboard to one of the USB ports in order to edit the BIOS settings.

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

---

**Warning**

Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.

---

**POST Screen**

1. BIOS information
2. CPU type
3. Memory status
4. Enter **Setup** prompt appears only during **POST**

**Note:** The POST screen as pictured right is for guideline purposes only. The POST screen on your computer may appear slightly different. If you disable the Boot-time Diagnostic Screen (see page 5 - 9), the POST screen will not appear.

**Figure 5 - 1**

POST Screen

---

Phoenix TrustedCore(tm) NB
Copyright 1985-2006 Phoenix Technologies Ltd. All Rights Reserved

- Bios Revision: ********
- KBC/EC Firmware Revision: ********
- CPU = 1 Processors Detected
- Intel(R) Atom(TM) CPU Z250 @ 1.33GHz
- 1015M System RAM Passed
- 512KB L2 Cache
- System BIOS shadowed
- Video BIOS shadowed
- Fixed Disk 0: TOSHIBA MK1246GSX
- Mouse initialized

Press <F2> to enter SETUP
Failing the POST

Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Note that you will need to attach a USB keyboard to one of the USB ports in order to edit the BIOS settings.

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
Large Disk Access Mode (Main Menu)
This refers to the representation of hard disk drive geometries as addressed by different operating systems. Select “Other” if you are using systems such as Novell, UNIX etc. Select “DOS” (default) if you are using Windows.

Primary Master/Primary Slave (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a HDD/optical device on the computer’s Primary Master/Primary Slave channels is applicable. Use the Auto (Type:) setting to have the items configured automatically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.
Advanced Menu

Installed O/S (Advanced Menu)

This setting tells the computer what kind of operating system you’re using. Make sure you choose the correct setting for your O/S in order to prevent system problems.
**Reset Configuration Data (Advanced Menu)**
This item is set to **No** as default. You can change the setting to **Yes** if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

**Boot-time Diagnostic Screen (Advanced Menu)**
Use this menu item to enable/disable the Boot-time Diagnostic Screen (see *Figure 5-1 on page 5-2*).

**POST Beep Sound (Advanced Menu)**
Use this menu item to enable/disable the beep as the computer starts up.

**Battery Low Alarm Beep (Advanced Menu)**
Use this menu item to enable/disable the battery low alarm beep.

**Hyperthreading (Advanced Menu)**
Hyperthreading will increase performance of your computer, depending on the hardware and software you use, by activating additional CPU threads. Make sure your OS supports Hyperthreading if you are installing a non-*Windows* OS.
Security Menu

The changes you make here affect the access to the **Setup** utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.

**Set Supervisor Password (Security Menu)**

You can set a password for access to the **PhoenixBIOS Setup Utility**. This will not affect access to the computer OS, (only the **PhoenixBIOS Setup Utility**).
Set User Password (Security Menu)
You can set a password for user mode access to the **Phoenix SecureCore Setup Utility**. This will not affect access to the computer OS, (only the *Setup* utility) unless you choose to set a **Password on Boot** (see below). Many menu items in the **Phoenix SecureCore Setup Utility** cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

Diskette access (Security Menu)
If you have set **Supervisor** and **User** passwords, you can set the level of access to any attached diskettes here.

Virus check reminder (Security Menu)
You can set a virus check reminder here to be enabled at system boot. The reminder can be set to be given **Daily**, **Weekly** (every Monday), or **Monthly** (on the 1st day of the month).
System backup reminder (Security Menu)
You can set a system backup reminder here to be enabled at system boot. The reminder can be set to be given Daily, Weekly (every Monday), or Monthly (on the 1st day of the month).

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.
Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows Vista) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Modules

Overview
This chapter contains information on the following modules, which come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

• Bluetooth Module (Factory Option)
• Wireless LAN Module
• PC Camera Module
• Fingerprint Reader Module
• GPS Module
• RFID Reader Module

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Bluetooth Module

The operating system’s Bluetooth Devices (the Bluetooth module is a Factory Option) control panel is used to configure the Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the On-Screen Menu button to power ON the Bluetooth module (see “On-Screen Menu” on page 1 - 18).

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the On-Screen Menu button to toggle power to the Bluetooth module, and check the menu icon to see if the module is powered on or not (see Table 1 - 4, on page 1 - 19).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the On-Screen Menu button to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the On-Screen Menu button to toggle power to the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control panel.
   - Double-click the icon to access the Bluetooth Devices control panel.
   - Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Bluetooth Devices (Hardware and Sound).
   - Click/Right-click the icon and choose an option from the menu.

![Bluetooth Taskbar Icon](image)

If you cannot see the Bluetooth icon in the taskbar, access the Bluetooth Devices control panel. Click Options (tab), and make sure that Show Bluetooth icon in the notification area check box (Connections) has a tick inside it.

Note that you will need to check the LED indicator to see if the module is powered on or not.

![Figure 6 - 1](image)
6 - 4 Bluetooth Module

To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that *Allow Bluetooth devices to connect to this computer* check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
5. Click to select “My device is set up and ready to be found”, and then click Next.
6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.
9. Click Finish.

---

**Passkey Options**

You can allow the system to choose a passkey for you. You will then be prompted to enter the generated passkey on your Bluetooth device.

---

**Figure 6 - 2**
Add Bluetooth Device Wizard

**Figure 6 - 3**
Passkey Option
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.
Wireless LAN Module

Before installing the WLAN module driver use the On-Screen Menu button to power ON (the default setting is OFF) the WLAN module (see “On-Screen Menu” on page 1 - 18). Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

802.11b/g Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon, and then click **Connect to a network** (or **right-click** the icon, and then click **Connect to a network**).

2. In the **Show** list, click to choose **Wireless** from the drop-down menu.
3. A list of currently available networks will appear.

You can also use the **Network and Sharing Center** control panel in Windows (**Network and Internet**) to connect to any available wireless networks.
4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or network (a list of options will appear allowing manual searching, and creating a new network).

6. Move the cursor over the taskbar icon to see the connection status (see below).
7. To disconnect from the wireless network you can click the taskbar wireless icon, and then select **Connect or disconnect** to access the network menu, and click Disconnect (or **right-click** the icon, and then click **Disconnect from**).
Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Windows Mobility Center (Mobile PC)**.
3. Click the button to **Turn wireless off/on**, or click the icon to access the network menu.

![Windows Mobility Center](image-url)
PC Camera Module

Before installing the PC Camera module driver use the On-Screen Menu button to power ON (the default setting is OFF) the PC Camera module (see “On-Screen Menu” on page 1-18). Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

PC Camera Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click 2. Install Camera Driver > Yes.
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the desktop, or from the BisonCam item in the Start > Programs/All Programs menu (if the hardware is turned off use the on-screen menu to turn it on again).

Camera Button

Press the Camera Button to run the BisonCap application program.

When the BisonCap application is running, press the Camera Button to take a still picture (see also “Taking Still Pictures” on page 6 - 16).

Note press the Camera Button and release it after you hear the camera shutter sound. Note that holding the camera button down will not take multiple pictures, you must press and release the button to take pictures (after the shutter sound is heard you will be ready to take further pictures).
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
11. Go to the Options menu heading and select Audio Capture Filter to adjust the audio options.
Figure 6 - 11
Audio Setup for PC Camera

Right-click
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 6 - 12) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the “Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 6 - 15 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 6 - 14), limit the file size of the captured video (see “Pre-Allocating File Space” on page 6 - 14) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Modules

Zoom
The **BisonCap** program allows you to zoom the camera in and out.

1. Run the **BisonCap** program.
2. Go to **Zoom** and select **Zoom Out/Zoom In**.

Note that the **Zoom Mode** buttons DO NOT zoom the camera, but do allow you to zoom in and out of captured pictures (e.g. jpeg files etc.).

Taking Still Pictures
The **BisonCap** program allows you to take still pictures.

1. Run the **BisonCap** program.
2. Go to **Options** and select **Take Picture**.

**OR**
3. When the camera is on, press the **Camera Button** to **take a still picture**
4. The picture (in JPEG format) will be placed in the **Snapshot** folder on the desktop.

Note press the **Camera Button** and release it after you hear the camera shutter sound (holding the camera button down will only turn **BisonCap** off).
Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click Option Drivers (button).
3. Click 3.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual
Right-click the taskbar icon to bring up the menu to select Help.

Insert the Device Drivers & Utilities + User’s Manual disc and click Option Drivers (button). Click Unlock (button) and then click 3.Install Fingerprint Driver >Yes.

Click Documentation to open the folder containing the manual in.pdf format.

To install the Adobe Acrobat Reader software to read the file, insert the Device Drivers & Utilities + User’s Manual disc and click User’s Manual (button), and click Install Acrobat Reader (button).
User Enrollment

1. Click Start > Programs/All Programs > Protector Suite > Control Center, or double click the taskbar icon (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If you have not set a password Protector Suite cannot secure access to your computer).
4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get help with fingerprint enrollment at any time).

Figure 6 - 13
Fingerprint Enrollment

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
6. Click the button above any of the fingers to begin the enrollment process for that finger.
7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click **Save and Continue**.
9. Enter a backup password and click **Apply**.
10. Close the fingerprint status window.

**Figure 6 - 14**
*Fingerprint Status*

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
11. Right-click the taskbar icon and select **Start Control Center** (and then swipe a finger) to allow you to **Edit Fingerprints**, register **Applications**, edit **Settings** and access the **Help** menu etc. You can also run the **Control Center** etc. from the **Protector Suite** item in the **Programs/All Programs** menu.

12. Click “**Help**” in **Control Center Home** to get more information on any topic.

13. You can also run the **Tutorial**, or **Product Tour** video to get more information.


15. If you swipe your finger over the reader at any time you can access the **Biomenu** to **lock the computer**, register **websites**, access the **Personal Safe**, **E-Wallet** or **Strong Password Generator**, open the **Control Center** and access the **Help** menu.
Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular finger. Simply copy the application icon on to one of the registered fingers and ten click OK to close the application window. Once registered the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for web sites etc.

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant to dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such as credit card details, account numbers etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be protected by fingerprint protection.

Help
For more information on these and other features simply access "Help" in the Fingerprint Control Center and select the item from the menu on the left.
GPS Module

If you have included an Global Positioning System (GPS) receiver module in your purchase option, you will need to obtain map software suitable for your global location. Map software programs are both commercially available and downloadable directly from the internet.

A Global Positioning System satellite continually transmits high-frequency radio signals containing the time and location of the satellite in relation to the earth. Your computer’s GPS receiver obtains information from satellites and calculates your current position on the planet (to an accuracy of between 3 and 15 meters). Toggle power to the GPS module using the On-Screen Menu button.

For the best quality signal use the optional antenna and screw the antenna into the GPS Active Aerial Socket at the rear of the computer (see “System Map: Rear View” on page 1-21).
Configuring the COM Port for the GPS Module

You need to make sure that the COM port for the GPS module is set to **COM 3** at a **4800 baud** rate. To do this follow the instructions below:

1. Click **Start** (menu), point to **Settings** and click **Control Panel** (or click **Control Panel**).
2. Double-click **Device Manager** (icon); **Device Manager** (icon) is in **Hardware and Sound** (category).
3. Click “+” next to **Ports (COM & LPT)** if its sub-items are not shown.
4. Double-click **Communications Port (COM3)**.
5. Click **Port Settings** (tab) and make sure that the **Bits per second** rate is set to **4800 baud**.
6. Click **OK** and close the **Device Manager**.

![Figure 6-16: COM3 Port Settings for the GPS Module](image)
RFID Reader Module

If you have included the RFID Reader module in your purchase option, you will need to obtain software suitable for your system. The scanner for the module is located at the top of the computer.

- For RFID Reader - Simply hold any RFID enabled card (up to a distance of 2CM) in front of the scanner to obtain a reading.

RFID Specifications

The RFID reader (maximum usable range of up to 2CM) is compliant with ISO standard for RFID Air Interface 18000 - Part 3 at 13.56MHz, and with ISO Standard for Proximity Cards - ISO 15693 Vicinity Cards or Smart Tags (Tag-it HF-I Plus; Tag-it HF-I Pro/Standard; I-Code2).

See “Configuring the COM Port for the RFID Reader” on page 6 - 25.
Configuring the COM Port for the RFID Reader

You need to make sure that the COM port for the RFID reader is set to COM 1 at a 9600 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click Device Manager (icon); Device Manager (icon) is in Hardware and Sound (category).
3. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
4. Double-click Communications Port (COM1).
5. Click Port Settings (tab) and make sure that the Bits per second rate is set to 9600 baud.
6. Click OK and close the Device Manager.
Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a **power strip**, make sure it is actually working. Check the **LED Indicators** (see “LED Indicators” on page 1-16) to see the computer’s power status.

- **Connections** - Check all the **cables** to make sure that there are no **loose connections** anywhere.

- **Power Savings** - Make sure that the system is not in **Hibernate** or **Sleep** mode by pressing the power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the **on-screen menu** to adjust the brightness.

- **Boot Drive** - Make sure there are no **optical media and/or USB storage devices** in any connected drive (this is a common cause of the message “**Invalid system disk - Replace the disk, and then press any key**” / “**Remove disks or other media. Press any key to restart**”).
Backup and General Maintenance

- Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.

- Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 - 2).

- Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

**Warranty**

The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.
Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing (please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty).

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When adding a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have added (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

- Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Troubleshooting

## Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery <strong>LED power indicator</strong> , is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are <strong>losing battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a Power Options scheme (see “Power Schemes” on page 3 - 4) check its settings. You may also be using a ExpressCard/USB device/external device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected. | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9).  
**Power Options have been disabled.** Go to the Control Panel in Windows and re-enable the options.  
A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn off/remove the unused device to save power. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td><em>Make sure the computer isn’t sitting on a thermal surface</em>. Make sure you’re using the correct adapter. Make sure that your computer is completely powered off before putting it into a travel bag (or any such container).</td>
</tr>
<tr>
<td><strong>Nothing appears</strong> on screen.</td>
<td><em>The system is in a power saving mode</em>. Press the power button (see “Configuring the Power Button” on page 3 - 8). <em>The screen controls need to be adjusted</em>. Toggle the screen control key combinations from the on-screen menu. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. <em>The computer is set for a different display</em>. Toggle the on-screen menu display key button. If an external monitor is connected, turn it on.</td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “Intel Video Driver Controls” on page B - 1 for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td><em>If you forget the password, you may have to discharge the battery of the CMOS.</em> Contact your service representative for help.</td>
</tr>
<tr>
<td></td>
<td><strong>Password Warning</strong></td>
</tr>
<tr>
<td></td>
<td>If you choose to set a boot password, <strong>NEVER</strong> forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.</td>
</tr>
<tr>
<td>The system never goes into a <strong>power saving mode</strong>.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6. Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN</strong>, <strong>Bluetooth</strong>, <strong>GPS</strong>, <strong>PC Camera</strong> or <strong>RFID</strong> modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the the on-screen menu to see if the module is on or off. The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Modules” on page 6 - 7).</td>
</tr>
</tbody>
</table>
The Hibernate function has disappeared (in Windows Vista).

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack 1. To re-enable Hibernate mode go to the Command Prompt and type the command "powercfg -h on" (make sure you are logged on as an Administrator):

1. Click Start (menu button).
2. Type “cmd” in the Start Search box.
3. Double click the Command Prompt when it appears in the menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.

Ports and Jacks

<table>
<thead>
<tr>
<th>View</th>
<th>Port/Jack</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left View</td>
<td>1. Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td></td>
<td>2. DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td></td>
<td>3. USB Port</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>View</th>
<th>Port/Jack</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right View</td>
<td>4. Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. Note: Set your system's volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td></td>
<td>5. External Monitor Port</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD.</td>
</tr>
<tr>
<td>Top View</td>
<td>6. RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td></td>
<td>7. USB Port</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: Intel Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 26.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached CD/DVD drive.
2. Click Install Drivers.
3. Click 3.Install Video Driver > Yes.
4. Click Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.

DVMT Notes
- DVMT is not local video memory.
- DVMT is not user-configurable.
- DVMT will not function in MS-DOS. DOS uses the legacy memory indicated.
Intel Video Driver Controls

Intel Graphics Properties

More advanced video configuration options are provided by the Intel(R) Graphics Media Accelerator Driver for ultra mobile.

1. Open the Display Settings control panel (see “Video Features” on page 1 - 26) and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).

Taskbar Icon

The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

If you cannot see the tray icon click the “Show Tray Icon” tickbox in the Intel(R) Graphics Media Accelerator for ultra mobile tab.

Figure B - 1
Intel Graphics Properties
You may make changes to the devices, color, schemes, Hot Keys etc. by clicking the appropriate menu item or button. Click Information (button) to obtain useful information about the graphics properties of the computer, and see the Support tab in Information to get weblinks to the latest information on the Intel Website.

Help Menus

Right-click on many of the items in the tabs to bring up the "What's This?" button.

Click the "What's This?" button to bring up the help menu.

Multiple Display

At least one other display must be attached in order to view Multiple Display options.

Figure B - 2
Intel Graphics Media Accelerator Driver for ultra mobile (Control Panel Tabs)
Display Settings
You can adjust the Color Quality, Screen Resolution and Refresh Rate for any attached display(s) from the Intel(R) GMA Driver for ultra mobile control panel, or from Display Settings (see page 1 - 26) in Windows.

Note: MID (Mobile Internet Device) is the computer’s LCD display.
Power Settings

Use the **Power Settings** control to allow the Intel(R) GMA Driver for ultra mobile control panel to adjust the power options when the computer is running on battery power. To set the power settings:

1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B - 2) and click **Display Settings**.
3. Click **Power Settings** (button).
4. You can adjust the slider to achieve a balance between maximum quality, and maximum battery life.
5. Enabling **Intel(R) Automatic Display Brightness** will allow the in-built controls to adjust the display backlight according to the ambient lighting.
6. Enabling **Intel(R) Display Power Saving Technology** will allow the in-built controls to adjust the brightness and contrast of the display.

![Power Settings](image)

*Figure B - 4  
Power Settings*
Attaching Other Displays

Besides the built-in LCD, you can also use an external monitor/flat panel display, connected to the external monitor port at the rear of the computer, as your display device. The following are the display options:

1. The built-in LCD OR an external monitor/flat panel display connected to the external monitor port (Single Display).
2. The built-in LCD AND an external monitor/flat panel display connected to the external monitor port (Multiple Display).

Configuring Displays from Windows Vista

1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preference, or click Display Settings to access the control panel.

On-Screen Menu Button
You can use the On-Screen Menu button to quickly toggle through the display options.

Figure B - 5
Windows Mobility Center
Configuring Displays from Intel® GMA Driver for ultra mobile

1. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
2. Click to choose the display option from the Multiple Display menu.
3. Click Apply (and OK to confirm the settings change) and OK (button).

Multiple Display
At least one other display must be attached in order to view Multiple Display options.

Figure B - 6
Intel GMA Display Devices
Display Modes

Single Display
Only one of your attached displays is used.

Intel(R) Dual Display Clone (mirrored)
This mode will drive multiple displays with the same content. Each device may be configured independently for different resolutions, refresh rates, color quality etc. Use this feature to display the screen through a projector for a presentation.

Extended Desktop (extended)
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for display. Use the Display Properties control panel to drag the monitors to match the physical arrangement you wish to use, or you may also use the Extended Desktop Settings control panel tab in Graphics Properties to configure the relative size and position.
To Enable Intel(R) Dual Display Clone

1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.
To Enable Extended Desktop
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel GMA control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Extended Desktop (Multiple Display).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Display Settings

You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can support them.

You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.
Using Windows Vista to Enable Extended Mode

1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Display Settings
Extended Desktop

Use the control panel to drag the monitors to match the physical arrangement you wish to use.
You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.

Figure B - 9
Display Properties
(Extended Desktop)
Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 26).
3. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary Display 1 is on the left, the Secondary Display 2 is on the right.

Figure B - 10
Display Properties
(Extended Desktop)
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your service center for details.

Upgrading the Memory and HDD/SSD

If you want to upgrade your computer by upgrading the system memory or the hard disk drive/solid state drive you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the mainboard. The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.
## Specifications

<table>
<thead>
<tr>
<th>Processor Options</th>
<th>Video Adapter</th>
<th>Audio</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel® Atom Processor:</strong></td>
<td>Intel® US15W Integrated Video</td>
<td>Intel® High Definition Audio</td>
</tr>
<tr>
<td>512K On-die L2 Cache, 533MHz FSB, FC-BGA8 Package</td>
<td>(Intel® Graphics Media Accelerator 500)</td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td><strong>Z520 (1.33GHz), Z530 (1.60GHz), Z540 (1.86GHz)</strong></td>
<td>Video Camera</td>
<td>2 * Built-In Speakers (1.5W)</td>
</tr>
<tr>
<td></td>
<td>2M Pixel Video Camera Module with USB Interface</td>
<td></td>
</tr>
<tr>
<td>Core Logic</td>
<td>BIOS</td>
<td>Button Keys</td>
</tr>
<tr>
<td>Intel® US15W Chipset</td>
<td>G-Sensor Software HDD Drop Protection from 40cm when system is powered on</td>
<td>5 Directional Key Buttons (Camera,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zoom, Page Up, Page Down &amp; Menu)</td>
</tr>
<tr>
<td>LCD Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.9&quot; WSVGA (1024 * 600) TFT LED Backlight LCD with Touch Panel (Stylus Pen &amp; Finger Sensitivity) - <strong>Factory Option</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.9&quot; WSVGA (1024 * 600) TFT LED Backlight LCD with Touch Panel (Stylus Pen &amp; Finger Sensitivity) - (Sunlight Readable with Brightness at least 350 nits) - <strong>Factory Option</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory</td>
<td></td>
</tr>
<tr>
<td>One 200 Pin SO-DIMM Socket Supporting DDRII (DDR2) 553MHz Memory Expandable up to 2GB</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Video Camera</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2M Pixel Video Camera Module with USB Interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BIOS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>G-Sensor Software HDD Drop Protection from 40cm when system is powered on</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Storage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shock Mounted Hard Disk Drive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SATA 2.5&quot; HDD or SATA Solid State Drive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Factory option) Single Level Cell</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Interface</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Two USB 2.0 Ports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One External Monitor Port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Headphone-Out Jack</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Microphone-In Jack</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One RJ-45 LAN Jack</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One Docking Connector</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Card Reader/ExpressCard</th>
<th>Power</th>
<th>Dimensions &amp; Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel® US15W Integrated 5-in-1 Card Reader (SD/ Mini SD/ SDIO/ MMC/ RS MMC) <strong>Note:</strong> Mini SD/ SDIO/ RS MMC Cards require a PC adapter One ExpressCard 34 Slot (see Approved ExpressCard list in Table E - 1, on page E - 1)</td>
<td>Full Range AC/DC Adapter AC input 100 - 240V, 50 - 60Hz, DC Output 19V, 1.58A or 19V, 1.57A (30 Watts) Li-Polymer 6600mAH Battery Pack Energy Star 4.0 Hot Swap Design Battery Gauge Indicator Battery Life Around 10 Hours</td>
<td>239mm (w) * 190mm (d) * 30mm (h) Around 1.5 kg With Battery</td>
</tr>
<tr>
<td>Communication</td>
<td>Operating System</td>
<td>Indicators</td>
</tr>
<tr>
<td>Built-In 10M/100Mb Base-TX Ethernet LAN Bluetooth 2.1 + EDR (Enhanced Data Rate) Module 802.11b/g Wireless LAN Mini-Card Module with USB interface GPS Module (Factory Option) HF RFID Reader (Factory Option)</td>
<td>Windows® Vista Home Basic 32bit (with Service Pack 1) Windows® XP (with Service Pack 3)</td>
<td>Power/ Suspend/ Battery/ HDD Battery Gauge</td>
</tr>
<tr>
<td>Security</td>
<td>Environmental Spec</td>
<td>Optional</td>
</tr>
<tr>
<td>Security (Kensington® Type) Lock Slot Fingerprint ID Reader Module BIOS Password</td>
<td>Temperature Operating: 5°C - 35°C Non-Operating: -20°C - 60°C Relative Humidity Operating: 20% - 80% Non-Operating: 10% - 90%</td>
<td>USB to RS232 Cable Docking Station (Power Charge and USB * 2) Input 12V-24Vdc, Output 19V Car Adapter, 60W Shoulder Strap/Carrying Handle/Hand Holder Charger Box One External 12.7 mm Combo/Super Multi USB Optical Device Drive</td>
</tr>
<tr>
<td>Power Management</td>
<td></td>
<td>See Over for Factory Options</td>
</tr>
<tr>
<td>Supports Wake on LAN</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**See Over for Factory Options**
Specifications

Factory Options

- GPS Module
- Bluetooth 2.1 + EDR (Enhanced Data Rate) Module
- HF RFID Reader
- 8.9" WSVGA (1024 * 600) TFT LED Backlight LCD with Touch Panel (Stylus Pen & Finger Sensitivity)
- 8.9" WSVGA (1024 * 600) TFT LED Backlight LCD with Touch Panel (Stylus Pen & Finger Sensitivity) - (Sunlight Readable with Brightness at least 350 nits)
Appendix D: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the *Windows XP OS*. 
Tablet Notebook Input

Use the stylus pen provided to interact with the computer in the same way you would use the mouse (tap twice to double-click and keep the pen in contact with the screen to right-click). Before using the stylus pen you should calibrate the touch screen.

Calibrating the Touch Panel

1. Double-click the Touch tool utility icon on the desktop OR from the Touch Package folder in the Programs/All Programs group (the driver must be installed).
2. Click General.
3. Click 9 pts Linearity (if you would prefer to calibrate more accurately, or are having distortion/tracking problems, then click Advance and choose either 25 pts Linearity).

![Figure D - 1 - Touch Package (General & Advance)]
4. Use the stylus pen to touch the blinking symbol until symbol changes color (maintain contact until the symbol stops blinking) and you will be prompted to lift up the pen.
5. Repeat the process for all the remaining screen points.
6. Click Free Draw (button) to test the calibration.
7. Use the Mouse Emulation and Sound control panels to further adjust the settings to your preference.

**Touch Panel Input Device**

Do not use any sharp or pointed objects as your input device e.g. the end of a pen or pencil. You should only use the provided stylus pen (PDA type) as your input device. Be very careful not to press too hard with the stylus pen when using it as the input device.

**Screen Distortion**

If you experience any line distortion, or tracking inaccuracy, recalibrate the touch screen using 25pts of calibration (click the Advance item in the Touch package and click 25pts Linearity).

*Figure D - 2 - Screen Calibration*
Windows XP Information

On-Screen Menu

Pressing the Menu button (or double-click the Pop Menu icon in the taskbar) on the computer will bring up the on-screen menu (make sure you install the pop menu driver - see “Pop Menu Utility” on page D - 35). Use the stylus pen to touch any of the buttons to activate the control. Press the Menu button (or double-click the Pop Menu icon in the taskbar) to quit the menu. Use the stylus pen to tap the appropriate on-screen button to adjust the setting and the button will display the current status.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the On-Screen Menu button to toggle power to any Wireless/Bluetooth/GPS module, and check the menu icon to see if the module is powered on or not.

Figure D - 3 - On-Screen Menu
### Table D - 1 - On-Screen Menu Buttons

<table>
<thead>
<tr>
<th>Function</th>
<th>On-Screen Button</th>
<th>Function</th>
<th>On-Screen Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness Decrease/Increase</td>
<td>![Brightness icon]</td>
<td>Bluetooth Module Power Toggle</td>
<td>![Bluetooth icon]</td>
</tr>
<tr>
<td>Volume Decrease/Increase</td>
<td>![Volume icon]</td>
<td>PC Camera Module Power Toggle</td>
<td>![Camera icon]</td>
</tr>
<tr>
<td>Mute Toggle</td>
<td>![Mute icon]</td>
<td>G-Sensor Protection Mode Toggle</td>
<td>![G-Sensor icon]</td>
</tr>
<tr>
<td>Display Toggle</td>
<td>![Display icon]</td>
<td>GPS Module Power Toggle</td>
<td>![GPS icon]</td>
</tr>
<tr>
<td>Display Battery Level</td>
<td>![Battery icon]</td>
<td>RFID Module Power Toggle</td>
<td>![RFID icon]</td>
</tr>
<tr>
<td>WLAN Module Power Toggle</td>
<td>![WLAN icon]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Any modules not included in your purchase configuration will appear grayed out when the key combination is pressed.

**Note:** Use the stylus pen to tap the appropriate on-screen button to adjust the setting.

**Note:** The default setting for the Wireless LAN and PC Camera modules is OFF.
G-Sensor - Hard Disk Drive Protection

The built-in G-Sensor gives protection to the system and hard disk (the G-Sensor does not function with Solid State Drives) in the event that the computer is accidentally dropped when the system is powered on (40cm drop approved when the system is powered on and 120cm drop approved when the system is powered off). Press the Menu button (or double-click the Pop Menu icon in the taskbar) to bring up the on-screen menu and use the stylus pen to toggle the G-Sensor mode ON or Off.

If the system is dropped, and the G-Sensor is on, the system will briefly pause (for about 3 seconds) to protect the hard disk and will display an on-screen message and an audible warning to inform that the hard disk is protected. Allow the system about 3 seconds to recover before using it again.

Set the G-Sensor On or Off in accordance with the manner the computer is being used. If the computer is sitting on the desktop (or if you find the G-Sensor is too sensitive), then the G-Sensor can be turned Off. The G-Sensor will be automatically activated to offer protection when the computer enters Sleep or Hibernate modes (even if turned off).
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.

Figure D - 5 - Start Menu & Control Panel
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices \(\text{Windows}\) control panel, or from the Realtek HD Audio Manager \(\text{Realtek Audio Manager}\) icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration menus). The volume may be adjusted by means of the On-Screen Menu buttons or the volume icon in the taskbar (see below).

![Sound Volume Adjustment]

How high the sound volume can be set depends on the setting of the volume control within Windows (and the volume control function keys on the computer). Click the Volume icon on the taskbar to check the setting.

Figure D - 6 - Realtek Audio Configuration Menus

D - 8 Audio Features
Video Features

You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate Intel video driver is installed.

To access Display Properties in Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution (Figure D - 7 on page D - 10).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 7 on page D - 10).
6. Click Advanced (button) (Figure D - 7 on page D - 10) to bring up the Advanced properties tabs.
7. Click Intel(R) Graphics Media Accelerator Driver for ultra mobile (tab), and click Graphics Properties (button) to make any video adjustments you require.
8. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
9. You can also access Intel(R) GMA Driver for ultra mobile from the taskbar icon menu.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
Display & Graphics Properties

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display connected to the external monitor port as your display device.

Taskbar Icon

You can also access the controller properties from the taskbar. Click on the icon to bring up the menu and scroll to Graphics Properties.

If you cannot see the tray icon go to the Intel(R) Graphics Media Accelerator Driver for ultra mobile tab and click the "Show Tray Icon" tickbox. Alternatively right-click the desktop and select Graphics Options > Tray Icon > Enable.

Figure D - 7
Display & Graphics Properties
You may make changes to the devices, color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button.

**Help Menus**

Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

**Multiple Display**

At least one other display must be attached in order to view **Multiple Display** options.

---

**Figure D - 8**

*Intel Graphics Media Accelerator Driver for mobile*
Windows XP Information

Attaching Other Displays

Besides the built-in LCD, you can also use an external monitor/flat panel display as a display device. The following are the display options:

1. The built-in LCD OR an external monitor/flat panel display connected to the external monitor port (Single Display).
2. The built-in LCD AND an external monitor/flat panel display connected to the external monitor port (Multiple Display).

If you want use an external display follow these instructions:

1. Attach your external monitor to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose the display option from the Multiple or Single Display menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).

**Intel Display Note**

Note that the notebook is the default Primary display device and may not be changed.

Note: MID (Mobile Internet Device) is the computer’s LCD display.

**Screen Resolution for Games and Power DVD**

Note that the screen resolution should be set to 800 * 600 if you are playing games, or are using the Cyberlink Power DVD program.

*Figure D - 9 - Display Devices*
Display Modes

**Single Display**
Only one of your attached displays is used.

**Intel(R) Dual Display Clone**
This mode will drive multiple displays with the same content. Each device may be configured independently for different resolutions, refresh rates, color quality etc. Use this feature to display the screen through a projector for a presentation.

**Extended Desktop**
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for display. Use Display Devices (tab) to drag the monitors to match the physical arrangement you wish to use, or you may use Windows Display Properties (control panel) to configure the relative size and position.

**Screen Rotation**
Use the screen rotation control from the Intel(R) GMA Driver for ultra mobile to rotate the screen to a portrait/landscape orientation (recalibrate the touch screen after orientation).
Windows XP Information

To Enable Intel(R) Dual Display Clone Mode
1. Attach your external display to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose Intel(R) Dual Display Clone from Display Devices (tab).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Figure D - 10 - Display Devices (Dual Display Clone) & Settings

D - 14 Display Modes
To Enable Extended Desktop Mode:
1. Attach your external monitor to the external monitor port and turn it on.
2. Open the Intel(R) GMA Driver for ultra mobile control panel.
3. Click to choose Extended Desktop from Display Devices (tab).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

You can also enable the Extended Desktop mode from Windows Display Properties (see page D - 16).
To Enable Extended Desktop (Display Properties)
1. Attach your external monitor to the external monitor port and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

Figure D - 12 - Display Properties (Extended Desktop)
Power Management Features

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

The **Power Options** control panel icon in *Windows* allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk, or you may use either **Stand by** or **Hibernate** mode to conserve power throughout the system.

**Advanced Configuration and Power Interface**

The **ACPI** interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in *Windows XP*.

---

**OS Note**

Power management functions will vary slightly depending on your operating system. For more information, it is best to refer to the user's manual of your operating system.

*(Note: All pictures used on the following pages are from the *Windows XP* OS.)*
Windows XP Information

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Press the power button to turn the computer “on”.
4. Remove the Stylus pen to use as your input device.
5. The LED indicators show the power and battery status of the computer.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page D - 28).
Turning on the Computer

Now you are ready to begin using your computer. To turn it on press the power button and release it.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when you press and release it in less than 4 seconds (pressing the power button without releasing it for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Shutdown
Note that you should always shut your computer down by choosing the Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.

Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination on an attached keyboard doesn’t work, press and hold the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button
If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s “Power Options” control panel to set the power button to send the system into Stand by or Hibernate mode.
Power Schemes

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Stand by** or **Hibernate** modes (see “System Power Options” on page D - 22).

*Resuming Operation*

Press a key on an attached keyboard, or move an attached mouse/TouchPad to resume from Monitor or Hard Disk Stand by.

*Figure D - 13*  
*Power Schemes*
Each Windows Power Scheme will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. Windows will use Portable/Laptop as the default scheme.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system features **Stand by** and **Hibernate** sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - see “Hibernate” on page D - 23).

**Hibernate Mode vs. Shutdown**

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

**Stand by Mode vs. Hibernate Mode**

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
Windows XP Information

Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button to power the system on.

System Resume
The system can resume from Stand by mode by:
• Pressing the power button.
• Pressing the Sleep/Resume key combination on an attached keyboard (if applicable).

Figure D - 14
Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer into either Stand by or Hibernate mode. In Stand by mode, the LED will blink green. In Hibernate mode the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving mode set to save power through individual components (e.g. hard disk, screen), the LED will remain green.
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 28 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Low Battery Warning
When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure D - 16
Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

If you need to remove the battery for any reason, see “Removing the Battery” on page D - 30.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 16 for information on the battery charge status, and to “Battery Information” on page D - 25 for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Close communication applications when they are not being used.
- Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).
- Disconnect any unnecessary external devices.
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.

Battery Guidelines
The following can also apply to any backup batteries you may have.

- If you do not use the battery for an extended period, then remove the battery from the computer for storage.
- Before removing the battery for storage charge it to 60% - 70%.
- Check stored batteries at least every 3 months and charge them to 60% - 70%.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see page D - 25) and Schemes (change all the settings to Never - see page D - 20). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Battery Gauge
The battery gauge at the rear of the computer provides a clear indication of remaining battery life. Firmly press the PUSH CHECK button and the Led will show the current battery level.
Battery Indicators
On-screen indicators will display the battery status if the battery level button \( \text{ } \) is pressed or the AC/DC adapter is not connected.

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The on-screen battery level button is pressed.</td>
<td>![Icon]</td>
<td>Main Battery Level Indicator</td>
</tr>
<tr>
<td>AC/DC Adapter Connection Removed</td>
<td>![Icon]</td>
<td>Bridge Battery Level Indicator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Main Battery Level is Under 3% Plug-in the AC/DC Adapter</td>
</tr>
<tr>
<td></td>
<td>![Icon]</td>
<td>Main Battery Level is Under 3% Change Battery</td>
</tr>
</tbody>
</table>

*Table D - 2 - On-Screen Battery Indicators*
Removing the Battery

If you need to remove the battery follow the procedure below.

1. Turn the computer off (unless you are hot swapping the battery), and turn it over.
2. Remove screws at points 1 - 4.
3. Remove the battery cover 5.
4. Grip the tab 6 and lift the battery out in the direction of the arrow 7.

*Figure D - 17 - Battery Removal*
Hot-Swapping the Battery

If you have more than one battery included in your purchase option you can swap the battery while the system is running.

1. Check the level of the backup battery from the on-screen menu.
2. Press the battery level button to display the indicator:

![Battery Level Indicator]

3. The lower indicator will display the bridge battery level and the upper indicator displays the main battery level.
4. If the bridge battery level indicated “Ready” you can swap batteries.
5. Remove the AC/DC adapter cable from the DC-In jack (if applicable) and an on-screen icon will indicate the main battery status if less than a 3% charge remains.

![Bridge Battery Ready Indicators]

6. You can then remove the battery as per the instructions in “Removing the Battery” on page D - 30.
7. When the battery is removed a beep will indicate that the system is running on bridge battery power (you have up to 3 minutes maximum to swap the battery depending upon applications being used).
8. When a new sufficiently charged battery is inserted the beep will stop.
Windows XP Information

Driver Installation

You will need to attach a CD/DVD drive to the computer in order to access the drivers on the Device Drivers & Utilities + User’s Manual disc. This contains the drivers and utilities necessary for the proper operation of the computer.

Click Install Drivers/Option Drivers (button) and then click the appropriate driver name from the Drivers Installer menu. Follow the instructions to install the driver.

1. Check the driver installation order from Table D - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become greyed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure D - 20 - Drivers Installer Screen 1

Figure D - 21 - Drivers Installer Screen 2
Windows XP Information

<table>
<thead>
<tr>
<th>WinXP SP3 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page D - 34</td>
</tr>
<tr>
<td>Video</td>
<td>Page D - 34</td>
</tr>
<tr>
<td>Audio</td>
<td>Page D - 34</td>
</tr>
<tr>
<td>LAN</td>
<td>Page D - 35</td>
</tr>
<tr>
<td>Touch Panel Application</td>
<td>Page D - 35</td>
</tr>
<tr>
<td>Pop Menu Utility</td>
<td>Page D - 35</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page D - 42</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page D - 44</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page D - 49</td>
</tr>
</tbody>
</table>

Table D - 3 - Driver Installation

Windows XP Service Pack 3

Make sure you install Windows XP Service Pack 3 (or a Windows XP version which includes Service Pack 3) before installing any drivers.

Driver Installation General Guidelines

The driver installation procedures outlined in this Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.
Windows XP Information

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc into the attached CD/DVD drive, click Install Drivers/Option Drivers (button) and then click the appropriate driver name from the Drivers Installer menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
LAN
1. Click 4. Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Touch Panel Application
1. Click 5. Install Touch Panel Driver > Yes.
2. Click Next > Next > Install.
3. Click Finish.
4. Click OK to restart the computer.
5. You will then need to calibrate the touch panel (see “Calibrating the Touch Panel” on page D - 2).

Pop Menu Utility
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “On-Screen Menu” on page D - 4 for details.

Module Drivers
See the following pages for the driver installation procedures for any of the optional modules included in your purchase configuration.
Windows XP Information

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows XP, and does not require a driver. See “Bluetooth Module” on page D - 37 for configuration instructions.

Wireless LAN Module
See “Wireless LAN Module” on page D - 42.

PC Camera Module
See “PC Camera Module” on page D - 44.

Fingerprint Reader Module
See “Fingerprint Reader Module” on page D - 49.

Bluetooth & Wireless LAN Modules

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Bluetooth Module

The operating system’s Bluetooth Devices (the Bluetooth module is a Factory Option) control panel is used to configure the Bluetooth settings in Windows XP, and therefore does not require a driver. Use the On-Screen Menu button to power ON the Bluetooth module (see “On-Screen Menu” on page D - 4).

- **Bluetooth Data Transfer**

  Note that transferring data between the computer and a Bluetooth enabled device is supported in **one direction only** (simultaneous data transfer is not supported).

  Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

- **Wireless Device Operation Aboard Aircraft**

  The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

  Use the On-Screen Menu button to toggle power to the Bluetooth module, and check the menu icon to see if the module is powered on or not (see Table D - 1, on page D - 5).
Bluetooth Local Area Connection Icon

If you want to display the Local Area Connection icon for the Bluetooth connection in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon.
2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick (if none is present) in the "Show icon in the notification area when connected" box and click OK.
4. Close the control panels and the icon for the Bluetooth local area connection will be displayed in the taskbar when connected (see sidebar and overleaf).

Figure D - 23
Local Area Connection
Bluetooth Configuration in Windows XP

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the On-Screen Menu button to toggle power to the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control panel.
   - Double-click the icon to access the Bluetooth Devices control panel.
   - Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Bluetooth Devices (Network and Interned Connections).
   - Click/Right-click the icon and choose an option from the menu.

![Bluetooth Taskbar Icon]

If you cannot see the Bluetooth icon in the taskbar, access the Bluetooth Devices control panel. Click Options (tab), and make sure that Show Bluetooth icon in the notification area check box has a tick inside it.

Note that you will need to check the LED indicator to see if the module is powered on or not.

![Figure D - 24: Bluetooth Devices & Click Icon Menu]
To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that *Allow Bluetooth devices to connect to this computer* check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
5. Click to select "My device is set up and ready to be found", and then click Next.
6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.
9. Click Finish.
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use On-Screen Menu button to power on the Bluetooth module after the computer resumes from Sleep.

Figure D - 27
Bluetooth Devices Options
Wireless LAN Module

Before installing the WLAN module driver use the On-Screen Menu button to power ON (the default setting is OFF) the WLAN module (see "On-Screen Menu" on page D - 4). Make sure you install the drivers in the order indicated in Table D - 3, on page D - 33.

802.11 b/g WLAN Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.
7. The operating system is the default setting for Wireless LAN control in Windows XP (see overleaf).
8. Access any available wireless networks from Network Connections > Wireless Network Connection menu in Windows (or click the icon in the taskbar), and click View Wireless Connections.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the On-Screen Menu button to toggle power to the WLAN module, and check the menu icon to see if the module is powered on or not (see Table D - 1, on page D - 5).
Use the *Windows Network Connections* control panel to access available wireless networks (Start > Settings > Network Connections or Start > Connect To > Show all Connections).

*Figure D - 28 Wireless Network Control Panels*
PC Camera Module

Before installing the PC Camera module driver use the On-Screen Menu button to power ON (the default setting is OFF) the PC Camera module (see “On-Screen Menu” on page D - 4). Make sure you install the drivers in the order indicated in Table D - 3, on page D - 33.

PC Camera Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click 2.Install Camera Driver > Yes.
3. Choose the language you prefer and click Next > Next.
4. Click Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the desktop, or from the BisonCam item in the Start > Programs/All Programs menu (if the hardware is turned off use the on-screen menu to turn it on again).
PC Camera Audio Setup

To capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio Input from the Mixer device menu.
5. Make sure the Mic Volume (check box) is checked, then click OK.
6. Boost the volume in the Mic Volume as high as it will go.
7. Close the Recording Control window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio Input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and capturing video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page D - 45) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the “Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page D - 47 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page D - 46), limit the file size of the captured video (see “Pre-Allocating File Space” on page D - 46) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Zoom
The **BisonCap** program allows you to zoom the camera in and out.

1. Run the **BisonCap** program.
2. Go to **Zoom** and select **Zoom Out/Zoom In**.

![Zoom/Setting](image)

*Figure D - 29 - Zoom/Setting*

Note that the **Zoom Mode** buttons DO NOT zoom the camera, but do allow you to zoom in and out of captured pictures (e.g. jpeg files etc.).

Taking Still Pictures
The **BisonCap** program allows you to take still pictures.

1. Run the **BisonCap** program.
2. Go to **Options** and select **Take Picture**.
3. When the camera is on, press the **Camera Button** 📷 to **take a still picture**
4. The picture (in JPEG format) will be placed in the **Snapshot** folder on the desktop.
Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into your external optical device drive.
2. Click Option Drivers (button).
3. Click 3.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.
**Windows XP Information**

**User Enrollment**
1. Click *Start > Programs/All Programs > Protector Suite QL > User Enrollment,* or double click the taskbar icon  (click *Initialize*).
2. On the first run of the program you will be asked to click the button to accept the license, and then click *OK.*
3. Click *Next* (the enrollment method will automatically be configured).
4. If you have not set a *Windows* password you will be prompted to do so (*note:* If you have not set a password *Protector Suite QL* cannot secure access to your computer).
5. Click *Finish.*
6. Click *Next.*
7. You will then be prompted to enter your *Windows* password and click *Next.*
8. Select either to use the fingerprint reader alone for authentication, or choose both the fingerprint reader and the *Windows* password, and then click *Next.*

![Multifactor](image)

*Figure D - 30*  
*Multifactor*
9. Click **Next > Next** (if you have the “Run interactive tutorial” tickbox selected you will run through the Fingerprint Tutorial).
10. Click **Next** for each window of the tutorial (you can click the button to “skip tutorial” at any time).
11. Click the button above any of the fingers to begin the enrollment process for that finger.
12. Swipe the finger five times to enroll that finger.
13. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click **Next**.
14. Click **Finish**.
15. Click “**Help**” in the **Fingerprint Control Center** to get more information on any topic.
16. You can also run the **Tutorial**, or **Introduction** (to run the product tour video) to get more information.

*Note that it is strongly recommended that you enroll more than one finger in case of injury etc.*

*Figure D - 31 Fingerprint Enrollment*
17. Right-click the taskbar icon to **Start Control Center** to allow you to **Edit Fingerprints**, register applications, manage **Password Bank**, **File Safe** and access the **Help** menu etc. You can also run the **Control Center** etc. from the **Protector Suite QL** item in the **Programs/All Programs** menu.


19. If you swipe your finger over the reader at any time you can access the **Biomenu** to **lock the computer**, register **websites**, access the **Personal Safe** open the **Control Center** and access the **Help** menu.
Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular finger. Simply copy the application icon on to one of the registered fingers and then click OK to close the application window. Once registered the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for web sites etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be protected by fingerprint protection.

For more information on these and other features simply access “Help” in the Fingerprint Control Center and select the item from the menu on the left.
GPS Module

If you have included an Global Positioning System (GPS) receiver module in your purchase option, you will need to obtain map software suitable for your global location. Map software programs are both commercially available and downloadable directly from the internet.

A Global Positioning System satellite continually transmits high-frequency radio signals containing the time and location of the satellite in relation to the earth. Your computer’s GPS receiver obtains information from satellites and calculates your current position on the planet (to an accuracy of between 3 and 15 meters). Toggle power to the GPS module using the On-Screen Menu button.

For the best quality signal use the optional antenna and screw the antenna into the GPS Active Aerial Socket at the rear of the computer (see “System Map: Rear View” on page 1 - 21).
Configuring the COM Port for the GPS Module
You need to make sure that the COM port for the GPS module is set to COM 3 at a 4800 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click "+" next to Ports (COM & LPT) if its sub-items are not shown.
5. Double-click Communications Port (COM3).
6. Click Port Settings (tab) and make sure that the Bits per second rate is set to 4800 baud.
7. Click OK and close the Device Manager.

Figure D - 33
COM3 Port Settings for the GPS Module
RFID Reader Module

If you have included the RFID Reader module in your purchase option, you will need to obtain software suitable for your system. The scanner for the module is located at the top of the computer.

• For RFID Reader - Simply hold any RFID enabled card (up to a distance of 2CM) in front of the scanner to obtain a reading.

RFID Specifications

The RFID reader (maximum usable range of up to 2CM) is compliant with ISO standard for RFID Air Interface 18000 - Part 3 at 13.56MHz, and with ISO Standard for Proximity Cards - ISO 15693 Vicinity Cards or Smart Tags (Tag-it HF-I Plus; Tag-it HF-I Pro/Standard; I-Code2).

See “Configuring the COM Port for the RFID Reader” on page D - 57
Configuring the COM Port for the RFID Reader

You need to make sure that the COM port for the RFID reader is set to COM 1 at a 9600 baud rate. To do this follow the instructions below:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click Device Manager (icon); Device Manager (icon) is in Hardware and Sound (category).
3. Click “+” next to Ports (COM & LPT) if its sub-items are not shown.
4. Double-click Communications Port (COM1).
5. Click Port Settings (tab) and make sure that the Bits per second rate is set to 9600 baud.
6. Click OK and close the Device Manager.

Figure D - 35
COM1 Port Settings for the RFID Reader
Windows XP Information
Appendix E: ExpressCard 34 Approved List

The ExpressCards listed in the table below are approved for use with this computer. Please make sure any ExpressCards you use with this computer are included in the list. For further information contact your service center.

<table>
<thead>
<tr>
<th>Model</th>
<th>Brand</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-In-1</td>
<td>APIOTEK</td>
</tr>
<tr>
<td>GIGA-LAN</td>
<td>Abocom</td>
</tr>
<tr>
<td>32G SSD ExpressCard</td>
<td>Transcend</td>
</tr>
<tr>
<td>16G SSD ExpressCard</td>
<td>Transcend</td>
</tr>
<tr>
<td>AVerMedia AVerTV DVB-T</td>
<td>AVerMedia</td>
</tr>
<tr>
<td>Brand Luxe 3.5G ExpressCard</td>
<td>Brand Luxe</td>
</tr>
<tr>
<td>Abocom Card Reader</td>
<td>Abocom</td>
</tr>
<tr>
<td>Merlin XU870 3G Card</td>
<td>Merlin</td>
</tr>
</tbody>
</table>

*Table E - 1 - Approved ExpressCards*
ExpressCard 34 Approved List